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Guideline to Back Up Your Computer And Important Files 

What is backing up? 

To backup is to make spare copies of file and store them separately to the originals. 

Why should you do it? 

In the world of computers loss of data can be devastating, and while there are possibilities for recovery 

of data after a disaster it is far easier to restore your files from backup than finding your data on a 

crashed hard drive. In fact, you can loss you data for not just one reason, many different situations may 

cause your data loss, such as: 

(i) Invasion and virus attack;  
(ii) Your computer hardware malfunctioning;  
(iii) Human error; or  
(iv) Other unpredictable causes.   

 

Therefore, the backing up important files is a very important and can save a lot of hassle if ever the PC 

has one of the above problems.  

Who should be responsible? 

Due to various reasons such as privacy and security issues, the backing up data in your computer should 

be your regular job. Other people may assist you but cannot guarantee that all your data has been 

backed up. Therefore, you are the only responsible person for the data in your computer.  You should 

consider when and often to back up, what media to use and most importantly what data to backup. 

How often is the backup recommended? 

How frequently you back up will depend on how often you use your PC and what you use it for. The 

average user will probably just have to back up any important files as and when they are changed and 

do a full back-up once a week/month. One rule of thumb would be if the important files change daily, 

back-up daily, if they change weekly, back-up weekly, and so on. 

What is the best backup media? 

There is no one-for-all for backup media. A best fit backup media depends on various factors: the 

importance of the data, the volume or size of the data and of course and the available tools and 

resources. As backup copies are supposed to be stored separately from the originals, removable media 

are recommended. 
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According to these criteria, you may select the one of the following media: 

User backup media Usual storage size Recommended backup usage 

Floppy disk 
 

1.4 MByte Obsolete and not recommended! 

Optical disk 
 

4 GBytes to 8 GBytes Storing more permanent data such as photo, 
data record…etc.  

External flash disk 
 

1 GBytes to 16 GBytes  Storing backup data of that may change quite 
often and the backup size is not very big. 

External hard disk 
(USB/eSATA) 
 

40 GBytes to 500 GBytes Recommended for all general backup purposes 
especially for large backup size is required. 

 

Traditional floppy disk has become obsolete due to its limitation in speed and storage size.  

Backup using optical disk such as DVD disk is quite common for data backup, the advantage is that, 

optical disks (except Blu-Ray) are very inexpensive (could be less than a dollar) and easy to store. In 

general, optical disk can be categorized into two types depending on whether it is write-once (R) and re-

writable (RW). If the backup data is not going to change, or at least not so often, write-once is 

recommended as it is cheaper and you will not accidentally delete your file in the disk. However, if the 

data may alter from time to time, using re-writable disk is recommended to save your money and it is 

more environmental. However, using optical disk as backup has its drawback. Backing up using optical 

disk is not as easy as to manipulating a floppy disk where you can save and take off files very easily. Each 

time you want to rewrite your disk, you must rewrite the entire disk and go through the entire burning 

process.  

With the increasing popularity of USB flash disk, using it as a backup medium becomes more and more 

popular. The size of a flash drive has been increased dramatically; however, it is still relatively expensive 

for backing up data using this medium. So if a large backup size is required, it is recommended to use 

external hard disk. 

External hard disk can interfaced with your computer commonly in one of the following ways: 

1) USB connection 

2) eSATA (external-SATA) connection 

The USB connection type is more common however eSATA has a speed advantage over USB. Since 

eSATA is still not very common, your computer may not have this connection available. Therefore, you 

must check the availability of this connection in your computer before employing it for backup. There is 

extra thing you need to remember when using external hard disk as your backup medium, this is 

important to know that hard disk can be easily damage due to shock. This is due to the fact that hard 

disks carry mechanical moving parts which are vulnerable to large vibration. Therefore, you need to 

handle them with care. 
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How to protect the data privacy of the backup? 

Everyone knows the risk on the loss of mobile storage devices, and also notice the effect of loss of 

information inside. Therefore, safeguarding data your backup in the devices is inevitably required. There 

are many protection solutions available, depends on your own needs, you may choose one or several of 

them. The protection solutions usually employ data encryption technique. The followings are some 

common encryption solutions: 

 Description Remarks 

BitLocker (Bundled with 
Windows Vista) 
 

Bundled encryption free to use 
in Windows Vista 

Domain user can be benefited 
from recovery of lost key 

TrueCrypt Encryption (open 
source freeware) 

Free encryption software that is 
compatible with different 
operating systems 

Can choose to use password or 
key file for authentication 

Hardware bundled encryption 
(flash disk, hard disk) 
 

Encryption software that is only 
work with its own hardware. 

Only a limited number of 
hardware suppliers are providing 
this option  

 

For Windows Vista users, it is recommended use BitLocker software since it is provided by Microsoft and 

this implies a sufficient future support available. Also, if you are working in the office’s intranet under 

the domain controller, you have no risk of losing or forgetting your encryption key, as the domain 

administrator can help you to reset your key whenever necessary. 

 

Do you need to backup ALL of your computer data? 

The short answer to this question is no, you do not need to back up all of the files on your computer. 

However, there are certain files you should definitely backup. So just what files should you be backing 

up? Although the choice is ultimately a personal one, here are some suggestions: 

 Email mailboxes and contact list  

 Internet browser bookmarks 

 Files relating to your work/projects  

The file locations for the first two are basically static, such that the programs which generate these files 

will be kept in fixed locations and may need to export them before every backup. The following is an 

example of backup email mailboxes for Outlook 2007 and Internet Explorer 7.0: 

Export Mailbox for Outlook 2007: 

1) Open your Outlook 2007 and click on the File menu. 

2) From the pull down File Menu, click on the “Import and Export …” item. 
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3) From the Import/Export Wizard window, select “Export to a file” from the “Choose an action to 

perform” box and then click “Next”. 

4) In the “Export to a File” window, select “Personal Folder File (.pst)” in the “Create a file type” 

box and then click “Next” to proceed. 

5) In the “Export Personal Folders” window, select the mailbox folder(s) to be exported. Then click 

“Next” to continue. 

6) In the next window, the “save exported file as” dialog appears, select the location you want for 

the destination of the exported mailbox file and remember the location. This is where mailbox 

file (pst) locates. Click “Finish” when you are ready to continue.  

Export Internet Explorer 7.0 (IE7) Bookmark: 

1) Open your IE7 and click on the File menu. 

2) From the pull down File Menu, click on the “Import and Export …” item. 

3) From the Import/Export Wizard window, select “Export Favorites” from the “Choose an action 

to perform” box and then click “Next”. 

4) In the “Export Favorites Source Folder” window, click “Next” to proceed. 

5) In the “Export Favorites Destination” window, remember the location indicated by “Export to 

file or Address” box. This is the location and file name of the exported bookmark. Click “Next 

when ready to continue.  

6) Just click “OK” and “Finish” to complete the export of bookmark process. 

After these exported files have been created, use one of the backup media and method to backup the 

files. Once these files have been saved, you can import them to any computers to regenerate the 

Outlook’s mailbox and Internet Explorer’s favorites by import in a similar fashion whenever it is 

necessary. 

For the backup of your work or project, the variation is existed due to different personal taste. Different 

people may have different location to store up these important data in the hard disk. The followings are 

some common areas to hold these files: 

\My Documents and subdirectories on any drive, except for My Videos, My Pictures, and My Music  

C:\Documents and settings and subdirectories  

C:\Windows\favorites  

C:\Windows\profiles  

For this reason, it is highly recommended that you store your data file in one single location for the sake 

of easy maintenance. This usually is the "My Documents" folder. 
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Label your Backups 

The backup media should be labeled as precisely as possible with the date, and some information to 

indicate what data has been backed up. You could alternatively keep more detailed records of what has 

been backed up on a separate piece of paper and just label a reference number on the backup media. 

 

Store your Backup Safely  

Copies of the back-up media, together with any notes on what has been backed up, should be stored 

safely e.g. in a locked drawer or fireproof safe. 

Ideally you should have a copy of the data in another location, at a sufficient distance away to escape 

any damage from a disaster (e.g. a fire or flood) at the location of the data i.e. the location of your 

computer. 

 

Backup Checklist  

When you have devised your backup strategy run through the checklist below : 

Are all data adequately and systematically backed up?  

Are the backup data securely encrypted? 

Are there adequate records of what is backed up and to where?  

Are there records of the licensed software?  

Are copies of the media and records stored remotely and safely?  

Can the new hardware read the backup media?  

Will the software license run on the new hardware?  

 

Example of Backup Tool in Windows XP/Vista environment 

It is advised to back up data using Microsoft’s default backup tools for Windows. The reasons are: 

1) It is a free bundled tool with Windows so there should have no compatibility problem. 

2) Backup can be scheduled. 

3) Easy to restore a file, a folder or even a whole system. 
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 The followings are typical procedure in Windows Vista: 

1) How to back up data in Windows Vista (Enterprise Edition)? 

2) How to restore data from backup in Windows Vista (Enterprise Edition)? 

3) How to back up data in Windows XP (Professional Edition)? 

4) How to restore data from backup in Windows XP (Professional Edition)? 
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1) How to back up data in Windows Vista (Enterprise Edition)? 

In the search field of the Start Menu, type the word “backup” and then click on the Backup and Restore 

Center shortcut as shown below. Alternatively, you can go to Control Panel -> System and Maintenance -

> Backup and Restore Center. 

 

The Backup and Restore Center has two main sections: back up and restore. 

 

The backup section offers another two options: Back up files and Back up computer. The first option will 

create a backup of your personal files and folders and the second will create a complete backup of your 

entire computer.  
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Start to backup your personal files and folders 

To start the procedure, click on the Back up files button and the wizard will start. 

 

In the Back up files window you will have to select where to save your backup. You can select an 

external hard disk, a DVD or a shared folder from your network. Click Next to continue. 

 

Then you will be asked which file type(s) you want to back up.  
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Next, you will be asked about the frequency of the back up such as daily, weekly or monthly. The 

scheduled backups will include only the new files or the modified files to the initial backup. 

 

Create the settings you want and then click on Save settings and start backup. 

The backup process will start. Depending on how much data you want to backup and the speed of your 

device, the procedure will take from a few minutes up to a few hours. You can stop the backup at any 

time by clicking on Stop backup. 

You will see the following screen if the backup is completed. 
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How to change the schedule or turn off your automatic back up? 

Again, you can use the start menu search box, type "backup" and click on the Backup Status and 

Configuration shortcut. 

 

The Backup Status and Configuration window will open. Here you will see the latest information about 

your backups. 
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If you want to make a new backup, click on the Back up now button. To change the current settings click 

on the Change back up settings button.  

If you want to disable the automatic backup, click on Turn off. 

 

Once you have finalized making all the desired changes, close the window. 

 

Start to create a complete PC backup 

This is different from back up only files and folders as mentioned above, backing up a complete PC can 

be used to recover the whole system including the operating system and the applications installed. To 

create a complete backup of your PC, go to the Backup and Restore Center and click on Back up 

computer to start the procedure. 

 

The wizard will start and you will be asked the location to save the backup. After you have made your 

choice, click Next to continue. 
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In the next window you will need to select the drive which you want to include in the backup. Make the 

appropriate selections and click on Next button. The following shows if you have one drive. 

 

Click on the Start backup button and the procedure will begin. The complete PC backup will normally 

takes a longer time than backing up files and it also requires a larger free disk space in the backup device. 
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2) How to restore data from backup in Windows Vista? 

In the search field of the Start Menu type the word 'restore' and then click on the Backup and Restore 

Center shortcut. Alternatively, you can go to Control Panel -> System and Maintenance -> Backup 

and Restore Center. 

 

In the Restore files section, you have two options: Restore files and Restore computer. As they are in 

similar fashion, this will cover the Restore files procedure only. 

 

How to restore files 

After clicking on the Restore files button, the wizard will ask if you want to restore files from the latest 

backup or from an older one. 
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Choose the option you prefer and then click Next button.  

Now you have to browse and add the files and folders that you want to restore according to the 

following steps: 

1) Click on the Add files or Add folders button. 

2) Find the files or folders that you want to restore, select them and click on the Add button (will 

show only the files and folders that were backed up). 

3)  Repeat this procedure until all the files or folders that you want to restore are present in the 

Restore Files window. 

4) After you have finished adding the files or folders that you want to restore, click on the Next 

button.  
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Now, you will be asked if you want to restore the files in their original location or in a different one. 

Choose the option you prefer and then click on the Start restore button. 

 

 If a same file is found in the same location, you will have to choose either: 'Copy and Replace', 'Don't 

copy', 'Copy, but keep both files'. 

 

When the restore process is completed, click on Finish. 
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3) How to back up data in Windows XP (Professional Edition)? 

The backup and restore utility in Windows XP is not as rich as Windows Vista, however, it still provides 

files and settings options. To start files backup, click the Start Menu button and select All Programs -> 

Accessories -> System Tools -> Backup.  

Click Next button when you see the Backup or Restore Wizard window. 

 

In the next screen, select Back up files and settings, and then click Next button. 

 

There are several locations in the your hard disk that may have your important data to back up, for 

example, My Document..etc. Choose the option you would like to backup. If your files you want to 

backup are located in different locations where you want to select them one by one, select Let me 

choose what to back up option and click Next button to continue. 
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In the Items to Back Up window, select the files or folders to back up and then click Next button. 

 

Choose the destination location to store the backup. This can be a folder in the any drive that you have 

write permission.  
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Click the Finish button to start the backup process. 

 

In the Backup Progress window, it will estimate how long that will take for the backup. 
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When the process is completed, click Close button to end. 
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4) How to restore data from backup in Windows XP (Professional Edition)? 

Starting up restore process is similar to starting up backup process in the last section, however, in the 

following diagram, select Restore files and settings and then click Next button.  

 

Select the files or folders that you want to restore. 

 

Click Finish button to start the restore process. 
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Again you will find a progress window showing the estimated time remaining. 

 

It will notify you when the process is completed. 

 


